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E STABLISHED IN 1976, DMA is a group of Dayton-area 
professionals and enthusiasts in the meld of computing 

and digital information technology. General membership 
meetings are usually on the last Tuesday of each month. 
DMA has a number of Special Interest Groups (SIGs) in ar-
eas ranging from digital investing and genealogy to the Linux 

operating system. Each SIG meets according to its own 
schedule. DMA is a member of the Association of Personal 
Computer Users’ Groups (APCUG) and the Aoliated Soci-
eties Council (ASC). Click on any of the logos—including 
our own (top left)—to go to that organization’s Web site. 

Post Office Box 
4005 

Dayton, Ohio 
45401 

Visit us at: 

DMA1.org 

Your 2018/19 
Oocers: 
President 
 Pater HESS 
Vice–President 
 Patrick CRAIG 
Secretary  
 Pat FLYNN 
Treasurer 
 Glady CAMPION 

Oocers need not be Trustees. 

Trustees: 
 Martin ARBAGI 
 Gary COY 
 Glady CAMPION 
 Patrick CRAIG 
 Pat FLYNN 
 Peter HESS 
 Brent KERLIN 
 Debra MCFALL 
 Gary TURNER 

Webmaster: 
 Brent KERLIN 
Webmaster Emeritus: 
  Dave LUNDY 

Submissions …  

T he Databus welcomes compliments, complaints, suggestions, and es-
pecially articles. We can accept articles in ASCII, or as attachments in 

Microsoft Word or Works, Open Office Writer, Word Perfect, or, yes, even 
WordStar (a word-processing program that goes all the way back 
to about 1980!). No PDF files, please. Send articles to: 

Editor@DMA1.org 

 All articles are subject to editing for spelling, grammar, usage, and 
space. Always retain a copy of your work, as The Databus cannot be re-
sponsible for loss. When articles are of roughly equal quality, those by 
paid-up DMA members usually receive preference. 

A ll registered trademarks, for example: DMA, G-Mail, or Microsoft 
Word are the property of their respective owners. However, the Reg-

istered Trade Mark symbols (® or ™) have been omitted for better reada-
bility. The Editor occasionally inserts comments into articles. Such com-
ments are often in square brackets [like these] and are always preceded 
by the phrase: “Editor’s Note.” 
 The Databus is written and published by volunteers. We do not give pro-
fessional advice on hardware, software, or network installation, repair, 
security, or troubleshooting. If you need expert assistance, please seek 
the services of a competent professional. 

http://www.dma1.org/
https://apcug2.org/
http://www.ascdayton.org/
http://www.dma1.org/
mailto:Editor@DMA1.org
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FEBRUARY MEETING: 7:00 P.M., Tuesday, the 29th, at T. J. Chump’s, 7050 

Executive Boulevard, Huber Heights  45424 (next door to Meĳer’s —click here 

for a map. Come at 6:00 P.M. if  you want to join us for dinner. There’s plenty of  

free parking. (Also accessible via RTA bus routes #18 & 19, but you must take 

a short walk over from the Meĳer’s supermarket.) 

No charge—bring a friend! 

PATRICK CRAIG:  
How Computers Empower Math Education 

T ODAY’S COMPUTERS are 
much more than overgrown 

calculators. They have the capabil-
ity to teach real-world mathemat-
ics, and make complex concepts 
much easier to understand. For 
generations, students have been 
taught to calculate by hand and 
also have been tested by hand. 
When computers were mrst em- 
ployed, they were simply used to teach students to calculate by hand. But the demands of today’s 
world have outpaced this type of education. We live in a much more complex, more quantitative 
world than ever before. As soon as students leave school and take jobs, they are required to aban-
don paper and pencil. Employees in all melds are required to complete their work on computers. 
Fortunately, educational techniques are beginning to catch up. The computer is a powerful tool 
for teaching complex concepts in new ways. People can sharpen their skills with a home computer 
and free online instruction.  
 How do we stop teaching calculating and start teaching math? By using computers, of course! 
 PATRICK CRAIG has a Master’s degree in Earth Science from Wright State University. For the 
past mve years he taught mathematics at Clark State Community College and is now also teaching 
Earth Science. Patrick is Vice President of DMA, a Trustee, and leader of the Scientimc Compu-
ting SIG. He is very passionate about computers and believes that their potential as a tool for ex-
ploration and education remains largely untapped.                                                                                                              … TDB 

 

No Charge–Guests Welcome–Bring a Friend 

https://www.bing.com/mapspreview?q=7050+executive+blvd+huber+heights+ohio&mkt=en&FORM=HDRSC4
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M inutes are normally published almost two months late, because the Minutes for, say, the 
January Board meeting must be approved by the Trustees at the following month’s 

meeting—in this case, early February. The corrected and approved January Minutes would thus 
usually appear in the February Databus (this issue), published toward the end of that month.  
 Time and place of the next Trustees’ meeting will be announced at the General Membership 
Meeting on Tuesday (the 26th). Trustees’ meetings begin at 7:00 p.m. and are open to all DMA mam-
bers. The Trustees sometimes meet for dinner beforehand at a nearby restaurant that will also be a 
anounced at Tuesday’s meeting. Whether Trustees will dine out beforehand, or if it’s a “bring your 
own microwaveable soup & sandwich” meeting, will also be announced. Those wishing to dine with 
the Trustees should come at 6:00.  

MINUTES–DMA BOARD OF TRUSTEES 
 
 

There was no 
quorum, and thus 

no Minutes, for 
the January 

Trustees’ 
meeting! 
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Longtime DMA member Steve Schoemann 
menaces our intrepid staff photographer with 
his Flush Gordon  combination alpha ray spear 
and toilet bowl cleaner, while Techfest  guests 

look on nervously. 

Gary Ganger views Steve’s threats with 
amusement, knowing he doesn’t really mean 

it. Besides, Steve’s recent plastic surgery 
makes him look more attractive than he used 
to!  Near Gary are snapshots of cutting-edge 
technology to wow the onlookers after Steve 

finishes his act. 

Techfest 
DMA had a strong presence at the 
recent Techfest, as these pictures 
by award-winning Staff Protogra-

pher Dave Lundy attest. 

DMA Secretary Glady Campion finds Steve’s act hilari-
ous. “Don’t worry,” she assures the young audience. 

“His bark is worse than his byte!” 

More Techfest 
on page 6. 

➔ 
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Former DMA President Grant Root 
(right foreground) charmed by a wide-

eyed young lady. Could she be a po-
tential Web page designer? Or (gasp!) 

possibly even a Linux freak? DMA 
member Chuck Gelm  is in the striped 
shirt. Who is that (green vest?) sitting 

next to Chuck? 

DMA’er Catherine Devlin explains Python (the pro-
gramming language, not the snake on her T-shirt) to a 

TechFest attendee. 

 
Excellent 

Attendance! 
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–Meet the New G-Mail– 
By Nancy DEMARTE, 1st Vice President, Sarasota Technology User Group, FL 
October 2018 issue, STUG Monitor 
www.thestug.org 
ndemarte (at) verizon.net 

G -MAIL IS A POPULAR E-MAIL SERVICE for good reason. Located in the cloud, it 
can be accessed from any computer, smart phone, or tablet. Once you become familiar with 

the interface, it is simple to use. A few months ago, I began to notice little changes to my G-Mail 
screen. Some things were moved; others were new. After a brief search, I found that G-Mail is in-
volved in a big makeover that began in the spring of 2018. G-Mail users are getting features as they 
become available, although everyone is not getting them at the same time. Here are a few of the 
changes that are included:  

Moves and Changes  
 The Contacts list has been moved from G-Mail to the 
center of the Google app grid. Click the grid (top right of 

G-Mail screen) to open it. This change has frustrated users 
looking to add or edit a contact. When composing an e-

mail, though, G-Mail still lists relevant Contacts when you 
begin to add a name. 

 The Google calendar icon has been added to the right 
side of the G-Mail screen. Now you can add events or re-

minders to it without leaving G-Mail. 
 When composing a message, you will now mnd four op-
tions for text size: Small, Normal, Large, and Huge. To set 
your personal font, size, and text 

color, go to Settings (Gear icon 
> Settings) and mnd the “Default 
Text Style” heading. Click the “Remove Formatting” icon 
(right end of toolbar), then set your preferences using the 

down arrows. To save changes in Settings, scroll to the 
bottom of the page and click “Save Changes.” 

 If you want to forward or reply to all recipients in the new G-Mail, skip the reverse arrow in 
the top right corner of the message. That sets up a Reply only to the sender. Instead, click the 
three vertical dots icon next to the arrow and make your choice. 
New G-Mail Main Menu (left side of screen)   
 Most of these commands are familiar to anyone who has used G-Mail. To save space, however, 
only the icons are visible until you move your mouse over them. Then the list opens to include the 
icon names. You can make it stay open by clicking the 3-lined icon in the top left corner of the 
screen, as shown. 

(Continued on page 8) 

http://www.thestug.org
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New G-Mail Icons & Features (right side of screen)  
 Google uses a lot of icons. The tiniest of them can have the biggest functions. To see what an 
icon means, hover your mouse pointer over it without clicking, and its name will appear, some-
times with more information. To use one of the features below, click it, and it opens as a right 
sidebar. 
✓ Google Calendar lets you view or edit your calendar without leaving G-Mail. 
✓ Keep lets you make notes and share them with others. 
✓ Use Tasks to create a To Do list and check oq items as they get done. 
✓ Get Add-ons takes you to the G Suite Marketplace, which has add-on features and 

apps you might like. 
Ten New or Updated G-Mail Features – Available Now or Coming Soon 
1.  Smart Replies: These are canned, informal replies which appear at the bottom of some mails. 
When in a hurry, click one and send it as your reply. 
2.  Snooze: Snooze lets you remove an e-mail from the Inbox and return it after a time you set, 
such as “tomorrow”. It is useful for messages that you want to answer at a later time. 
3.  Nudge: When enabled, this function will suggest e-mails that you should reply to or sent mails 
that require following up. Go to Settings to enable or disable it. 
4.  Conmdential Mode: These functions are designed to increase security. You can set a message to 
self-destruct at a specimc time, or you can send an e-mail that requires the recipient to enter a code 
before opening it. 
5. Importance Markers: Google determines which messages are “important” by putting a gold ar-
row next to them. 
6. Smart Compose: This feature is similar to the tablet or smartphone “auto-complete” function. 
As you type a message, and a few grayed out words complete the thought. If you like these words, 
just keep typing over them. If not, type something else. You must enable this feature in Settings. 
7. Labels: Labels (much like folders) are found in classic G-Mail but now have new icons. You can 
create labels (travel, personal, etc.) and put messages into them. Just open an e-mail to reveal the 
icon group shown. Click the “Label” icon to view the labels list or create a new label. To move a 
message into a label, click the Label icon, check the box next to a label, and click Apply. Click the 
“Move To” icon to get extra labels, like Spam or Trash. 
8. Opine Support: We know we can’t send or receive e-mail without the Internet. But G-Mail 
computer users can now compose, open or read G-Mail when not on the Internet. The Mobile G-
Mail version already has this capability. 
9. Assisted Unsubscribe: This feature targets people who have on-line subscriptions to newsletters 
and other regular columns which come via e-mail. If you don’t open one of your newsletters often, 
G-Mail will bring up a notice that lets you unsubscribe. 
10. Improved Spam Warnings: G-Mail has always popped up a notice when you try to open an e-
mail known to be unsafe. The new G-Mail has larger warnings with colors based on the level of 

(THE NEW G-MAIL—Continued from page 7) 

(Continued on page 9) 
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danger. Gray means Suspicious; Red indicates Dangerous.  
 Many of the new features can help you keep your mail organized or save time, but I found a 
few of them annoying. For example, I’m not sure I want to be “nudged” every time I wait too long 
to open an e-mail. Fortunately, most features can be enabled, disabled or hidden in Settings. A tip: 
Don’t ignore the little icons which can be crucial to make G-Mail function the way you want it to. 
 To mnd out if you already have the new G-Mail, open G-Mail and click the Settings 
(gear-shaped) icon. If the top line says, “Go back to classic G-Mail,” you have the new ver-
sion. You can click that line and return to the old G-Mail. Since you can do this at any 
time, consider trying out the new version for a while before you decide whether to keep it. 

 … TDB 

(THE NEW G-MAIL—Continued from page 8) 

Not Techfest! 
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–Six Little Word Problems and Their Solutions– 
By Nancy DEMARTE, 1st Vice President, Sarasota Technology User Group, FL 
November 2018 issue, STUG Monitor 
www.thestug.org / ndemarte (at) verizon.net 
 
1. You print a multi-page Word document and get an unexpected blank page at the end of the 
document. Because it has a footer, you won’t be able to use that sheet for anything except scrap 
paper. 
Solution:  Before you click Print, press the Show/Hide key (the ¶ icon) on the Home tab > Para-
graph group and scroll or press the Ctrl+End keys to get to the end of the document. You will see 
one or more paragraph icons on the last blank page. Select them and press Delete. Then save the 
document to avoid the blank page in future printings. [Editor’s Note: An even simpler way of doing 
this is to press Ctrl + End, and then merely Backspace to the previous page. This paragraph of Ms. De-
Marte’s article reminds me of a sad incident. Several years ago, an elderly lady of my acquaintance 
continually encountered this problem. It turned out she was in the early stages of Parkinson’s Disease, 
and the tremors that are a symptom of that tragic disorder caused her to hit the Return and Tab keys, 
as well as the Space bar many times when she only meant to depress them once.] 

2.  You open a document and mnd you have to squint to see the small type. 
Solution: Go to the Zoom slider at the bottom right of the screen and 
click the + sign a few times until the document text is large enough to 
be comfortable for your eyes. This will not aqect the text size when 
printed. 

3. You are just about done typing a Word document and notice that all the 
text in the last couple of sentences is in upper case. You had pressed the Caps 
Lock key on the keyboard accidentally. 
Solution:  First select the text you want to reformat. Then click the Change 
Case tool (Aa) on the Home tab > Font group. Click the case pattern you 
want from the list, which in this situation is probably “Sentence case.” 

4. Sometimes you forget what version of Windows you have on your com-
puter. “Version” includes the operating system (Windows 7, 8.1, or 10) and the Windows update 
version number, such as the recent update, 1803. But you’re 
not sure how to mnd the answer. 
Solution: To mnd the version of your Windows operating 
system, type in the Search box at the bottom left of the 
taskbar the word winver. Then click the winver run command to see your computer’s details. 

5. When you enter an email or web address in a document, by default Word automatically adds a 
hyperlink to the address. You can identify a hyperlink by its blue text and underline. Many times, 
you don’t want the hyperlink included. 

(Continued on page 12) 
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10% Discount to DMA 
members! 

 

Have a business card? Are you a DMA member? 

A ny paid–up member of the Dayton Microcomputer Association is entitled to a free business card–

sized advertisement in The Databus. Send a good–quality image to Editor@DMA1.org, or give 

your business card to Martin Arbagi, the Editor, at any DMA meeting. We can embed a link to your 

Web site (if you have one) in the image of your card. Under weird IRS regulations, your Web site may 

not include discount coupons for DMA members, although discount offers may be included in the ad-

vertisement itself. See the example below, which includes a member discount. But the advertiser 

could not have put the discount on his Web site. 

Call Letters: N8NRE 
2385 Ginghamsburg-Frederick Rd. 

Tipp City, OH  45371 
E-mail: Schoemann@Gemair.com 

mailto:gcoy@woh.rr.com
http://locknestmobilelocksmith.com/
http://www.whitewatervalleyrr.org/
mailto:Editor@DMA1.org
mailto:Schoemann@Gemair.com
mailto:Schoemann@Gemair.com
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Help DMA by using Amazon’s 
“Smile” program! 

A mazon, the Internet’s largest retailer (if you haven’t no-
ticed, Amazon isn’t just for books any more!) has a “Smile” 

feature whereby Amazon donates a percentage of almost any 
purchase you make to a selected nonprofit organization. There is 
no extra cost to you. Click here to learn more or here to go di-
rectly to the sign-up page. Be sure to put DMA down as the 
beneficiary of your purchases. 

Solution: There is a way to change the setting to stop the automatic hyperlink from being added. 
Click the File tab (top left of the ribbon), then click Options (last item on the menu). Click 
Proomng > AutoCorrect options > Autoformat and uncheck the last item on the Replace list, 
“Internet and network paths with hyperlinks,” then click OK. 
 Just to be safe, also click “Auto Format As You Type” and uncheck the same box there, fol-
lowed by OK. 
 While you are in the Word AutoCorrect area, check to see if you are being bothered by any 
other automatic action. If so, uncheck it and click OK. 
 If you change your mind, return to this screen and recheck the boxes. 
6. You have typed a long list of items, such as book titles in a bibliography, taking up several pag-
es of a Word document. Each title is on a separate line. You would like to mnd out how many 
items there are in the list, but counting them would be tedious. 
Solution: Select the entire list using Ctrl+A. Then on the Home tab - Paragraph group, click the 
numbering tool (top row, second from left) to place a number in front of each item. Then press 
Ctrl+End to jump to the end of the list, where you can view the last number. If you wish, press 
Ctrl+Z or Undo to remove the numbering.                                                                                                                             … TDB 

(SIX LITTLE WORD PROBLEMS—Continued from page 10) 

https://smile.amazon.com/about/?ref=spkl_3_0_2055499922&ie=UTF8&pf_rd_m=ATVPDKIKX0DER&pf_rd_s=desktop-auto-sparkle&pf_rd_r=08XEYSPQPYZ9W0BKR5WF&pf_rd_p=2055499922&pf_rd_t=301&pf_rd_i=amazon%20smile&qid=1427474572
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Dayton Microcomputer Association Membership Form 
Today’s Date: ____/____/________ 

(dd/mm/yyyy) 

❑  New Please credit the DMA member who recruited you:  
__________________________________ 

❑  Renew  Please list below any changes to your contact information. No changes? Don’t bother 
filling out this section of the form. 

Name: _____________________________________________________________________________ 

Address: ___________________________________________________________________________ 

City: ____________________________________________________ State: ______ Zip: ___________ 

Telephone (landline or cellular): ( _________ ) __________—________________ 

E-Mail: ______________________________________________________@______________⚫______ 

Skills or interests you can share with DMA: 

✓ ________________________________________________________________________________ 

✓ ________________________________________________________________________________ 

What do you hope DMA can provide you? ________________________________________________ 

Types of Membership: 
Regular ($25.00 annually)  ...................................................................................................................... ❑ 
Associate ($12.50 annually—For someone living at the same address as a Regular Member.) ........... ❑ 
Student (Free—For full-time students through 22 years of age. Student members cannot vote in  
DMA elections.) ....................................................................................................................................... ❑ 

Shell Account: A Shell Account on the DMA server provides file storage, hosting of a personal  
noncommercial Web site, and a DMA1.org e-mail alias (forwarding address), all for a one-time fee 
of $10.00. A user name must be no more than eight alphabetic characters. The usual default is 
your last name and first initial, with no caps or punctuation (for example, jsmith or sjones).  
DMA reserves the right of final decision on all user names. .................................................................. ❑ 

First choice: ____________________________   Second Choice: _____________________________ 

TOTAL …..…………………………….……………………………………………………………………………………. $________⚫____ 
Make checks or money orders payable to Dayton Microcomputer Association, and mail this Form and your payment to: 
Post Office Box 4005 Dayton, Ohio  45401. (At this time, we can only accept payment by check or credit card at meetings.) 

DMA USE ONLY: 

Member#____________Exp. ____/____/________  ❑ Check#_______   ❑ Cash    Processed by: _____________________ 

Member#____________Exp.____/____/________   ❑ Check#_______   ❑ Cash    Processed by: _____________________ 

Member#____________Exp.____/____/________   ❑ Check#_______   ❑ Cash    Processed by: _____________________ 


